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Product and Company Information 

The information in this document is confidential proprietary information belonging solely to Constellation 

HomeBuilder Systems, Inc., a wholly owned subsidiary of Constellation Software, Inc. This document is 

supplied under a license and may not be reproduced, published, or disclosed without prior written 

authorization. Constellation licenses its program products (software) to the customer in accordance with 

the terms and conditions of the BuildTopia Software License Agreement. No title or ownership of the 

BuildTopia software is transferred. Any use of the software beyond the terms of the aforesaid license, 

without the prior written authorization of Constellation, is prohibited.  

 

 

The names of companies, products, people, characters and/or data mentioned in screens, reports, and 

other data examples are fictitious and are in no way intended to represent any real individual, company, 

product or event, unless otherwise noted. Any rights not expressly granted herein are reserved.  

 

 

Trademark and Patent Information  

Other product and company names mentioned herein might be the trademarks of their respective owners.  

 

 

Disclaimer of Warranties and Limitation of Liabilities  

The staff at Constellation has taken due care in preparing this information; however, nothing contained 

herein modifies or alters in any way the standard terms and conditions of the BuildTopia License 

Agreement by which the product was acquired. Nor does it increase in any way Constellation’s liability to 

the customer. In no event shall Constellation or its affiliates be liable for incidental or consequential 

damages in connection with or arising from the use of the product, the accompanying documentation, or 

any related materials.   
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Contacting Support and Services  

Support for the BuildTopia software is available at Constellation’s Baltimore and Markham offices.  

 

 

Baltimore Main Office  
Telephone:  1 410 843-3800 

Fax:   1 410 843-3853  

Web:  http://www.constellationhb.com  

 

 

Customer Care 

Customer Care assists with software operations.  

 

Telephone: 1 800 411-2020 

Email:  support@buildtopia.com  

Hours: Monday through Friday 8:30 a.m. to 5:00 p.m. (Eastern Standard Time) 

 

Professional Services  

Contact your company’s Professional Services Consultant for assistance with software implementation, 

training, consulting, and data building. 

  

Telephone: 1 905 475-2209 or toll-free at 1 888 723-2222  

Fax:  1 905 475-7204  

Web:  http://www.constellationhb.com 
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Enhancements 

This section highlights new features and enhancements that have been added to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 

description of the item with any relevant screenshots to detail the enhancement. 

 

Sales 

 

Update to the options list on workups and agreements, options grouped by option category 

Defect #:  001-00-1-20471 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Workups > Manage Workup 

Sales > Buyers > Agreement (all tabs) 

Sales > SPECs > SPEC Accepted 

Project Management > Lot Matrix > Options 

The options section of workup and agreement pages in Sales, and the options list in 

Project Management has been updated to list options by option category. Within each 
category the options are sorted by option number.  

Screenshots:   

Sales > Prospects > Workups  
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Two new standard print forms: Pricing Addendum by Category and by Category & CO I by Category 

Defect #:  001-00-1-20472, 001-00-1-21243 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Buyers > Agreement > Pricing Addendum by Category 

Sales > Buyers > CO > Printer Icon > CO I by Category 

The two new print forms above have been added, and they show options organized by 

option category. 

 

Update to prevent addition of tasks if the prospect/buyer has opted out of that task type 

Defect #:  001-00-1-20685 

Ticket #:  001-00-237813 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Prospect Name > Actions > Add Task  

Sales > Buyers > Buyer Name > Actions > Add Task  

When adding an individual task to a prospect/buyer, task types that the prospect/buyer 

have opted out from will be hidden from the task type options, e.g. if a prospect has 
opted out of phone calls the ‘Phone Call’ task type will not be available. 

 

Documents 

 

Updated, easier to use HTML editor for emails 

Defect #:  001-00-1-20659 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Documents > Compose Email Template  

Documents > Profile (for an email document) > Edit  

The html editor has been updated, and is now easier to use. New features include ability 
easily add online pictures and advanced text tools. 

Screenshots:   

Documents > Compose Email Template  
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Reports 

 

Update to the Standard Traffic report to include all Projects 

Defect #:  001-00-1-21610 

Ticket #:  001-00-230532, 001-00-232441 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > Standard Reports > Sales Management > Traffic Report  

The standard Traffic Report has been updated to have the option to run for all projects. 

 

Update to Job Cost Reports to exclude activities with 0 as the quantity 

Defect #:  001-00-1-20853 

Ticket #:  001-00-231506 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > Standard Reports > Job Cost Report (Lot Detail - Activity) 

Reports > Standard Reports > Job Cost Report (Lot Detail - Profit)  

Reports > Standard Reports > Job Cost Report (Lot Summary - Profit) 

Reports > Standard Reports > Job Cost Report (Lot Summary) 

Reports > Standard Reports > Job Cost Summary - Management 

The Job Cost Reports have been updated to exclude activities that have 0 as the quantity. 

Since these activities have a quantity of 0, their budgets, committed costs etc. are all 0, 

but their inclusion on the detail versions of the Job Cost reports caused confusion. The 
reports have been updated to avoid this confusion. 

 

Update activity list datasets to exclude activities marked 'Never Generate' 

Defect #:  001-00-1-20682 

Ticket #:  001-00-223036 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > Purchasing > Activity List 

Reports > On-Demand Reports > Purchasing > Activity List w/Schedule Information 

The two data sets above have been updated to exclude activities that are marked as 

'Never Generate'. This has been done to give an accurate comparison of budgets to 
committed costs by excluding the budgets of activities marked as ‘Never Generate’. 
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Addition of last modified task date/user to schedule tasks/phases data sets 

Defect #:  001-00-1-20411 

Ticket #:  001-00-230532, 001-00-232441 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On Demand Reports > New Report > Scheduling > Scheduling Tasks 

Reports > On Demand Reports > New Report > Scheduling > Scheduling Phases 

Two new fields have been added to the 'Schedule Phase' section of these data sets: 'Last 

Modified Date' and 'Last Modified User' which show the last time a phase was updated and 
the name of the user that made the change. 

 

Messages  

 

Automated deletion of unarchived messages from the Messages Inbox 

Defect #:  001-00-1-15735 

Ticket #:  001-00-218647, 001-00-232660 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   My Profile  

Trade Partner Account > My Profile  

With release 6.7.1 we added settings in the ‘My Profile’ section that allowed users to 

choose how long unarchived messages will be retained in the Messages inbox. With 

release 6.7.2, the automated deletion of messages according to those settings will begin.  
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General 

 

General usability updates 

Defect #:  001-00-1-20079, 001-00-1-20278, 001-00-1-20791, 001-00-1-21078, 001-00-1-21168, 

001-00-1-21190, 001-00-1-21585, 001-00-1-21618, 001-00-1-21655, 001-00-1-21677, 
001-00-1-21721, 001-00-1-21722, 001-00-1-21723 

Ticket #:  001-00-240007, 001-00-240283 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The following updates have been made as part of the overall effort to make the 

application easier to use: 

• Sales > Price Plans: A new button, 'Save & Update Lots', has been added to allow the 

new price to be applied on selected lots. 

• Sales > Price Plans: Plan Name column was showing the plan number and plan name. 

It has been corrected to show the plan name only. 

• Sales > Buyers: the ‘Settlement Date’ link has been updated to ‘Settlement Date/View 

Schedule’ since the schedule is visible on the settlement date page. 

• Sales > Buyers > Agreement > Deposits tab: The Payment Type and Deposit Detail 

fields have been added to the deposits tab. 

• Sales > Buyers > Agreement > Actions > Create a Change Order & Sales> Buyers > 

CO > Edit: The ‘Deposit Notes’ field has been added to the deposits section. 

• Sales > Lot Matrix > View > Workups tab: The buyer’s name on the workups tab has 

been updated to be a link to go directly to that workup. 

• Sales > Price Options > Edit Option Price > select a category: The text for the option 

cost flag has been updated to explain that the flag identifies options that have costs 

coming from proforma budgets because primary finalized costs do not exist. 

• All workup/agreement pages: The NSO section on the workup and agreement pages 

has been updated to provide more space to the description field. The NSO section has 

also been updated to give more space to the NSO description field. 

• The ‘Username’ field for the homebuyer homepage has been increased to 100 

characters. 

• Documents > Search > Profile > Actions box > Visibility Wizard: re-organization of the 

tabs to make them easier to navigate, replacement of the select all/clear all buttons 

with a select all/clear all checkbox. 

• Admin > Projects > Lots: The ‘Selected Plan’ column has been added to show the plan 

under construction for each lot. 

• Admin > Company Setup > Budget Settings: The text for the budget settings have 

been updated to explain that the budget is captured when the activity list is created. 

• CS > Requests > Request Number > Notes tab: The notes tab for requests has been 

updated to improve the way detail is shown. 

• Trade Partner Account > Lots > Select Builder, Select Project > Active & Complete 

tabs: The ‘Selected Plan’ column has been added to show the plan under construction 
for each lot.  
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Defect Fixes  

This section highlights corrections and defect fixes that have been applied to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 

description of the item with any relevant screenshots to detail the defect. 

 

Sales 

 

Issue with project for incentives for workups 

Defect #:  001-00-1-20796 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Workups > Manage Workups > Actions > Add an Incentive 

If a workup is created for a prospect in a different project from the one where the 

prospect is registered, the incentives shown were for the prospect’s project instead of the 

workup’s project. This has been corrected so that the incentives shown are always from 

the same project as the workup.  

 

Issue with the 'Create/Edit Change Orders' sales permission 

Defect #:  001-00-1-20790 

Ticket #:  001-00-238919 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Sales Roles > View/Edit  

Sales > Buyers > Agreement > Actions > Create a Change Order 

Users with a sales role that includes the 'Create/Edit Change Orders' sales permission, but 

no other buyer permissions could not see the Actions drop down on the agreement pages, 
and therefore could not see the 'Create a Change Order' link. This has been corrected. 

 

Issue on the price options screen when cost information flag is used 

Defect #:  001-00-1-20385 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Price Options > Edit Option Prices > Choose an option category 

When the flag that shows options with incomplete cost information was checked, the 

numbers on the cost column would not be shown. This has been corrected. 
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Issue with the Deposit Type field for Deposits 

Defect #:  001-00-1-21570 

Ticket #:  001-00-241420 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Agreement > Actions > Add a Deposit 

Sales > Agreement > Deposits tab > Edit 

In some cases the deposit type selection was not saved when adding or editing a deposit 

on an agreement. This has been corrected. 

 

Issue with the sales rep drop down in the Advanced Search for prospects 

Defect #:  001-00-1-20855 

Ticket #:  001-00-235263 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Advanced Search  

Users who had a sales role that includes 'View Prospects and Tasks assigned to the User 

Only' permission were able to see other sales reps in the Advanced drop down. This has 
been corrected. 

 

Issue with the Homebuyer Homepage when an agreement is finalized 

Defect #:  001-00-1-20592, 001-00-1-20797 

Ticket #:  001-00-238070, 001-00-238363, 001-00-238815 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Buyers > Finalize 

In some cases the status of the homebuyer homepage was not changed to ‘Active’ when 

an agreement was finalized. This has been corrected. 

 

Issue causing duplicated document counts for SPECs 

Defect #:  001-00-1-18962, 001-00-1-20459 

Ticket #:  001-00-232289 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > SPECs 

In some cases the number of documents associated to SPECs was double the actual 

number. Additionally, an error message was shown after the ‘Back’ link on the documents 
list was clicked. This issue has been corrected. 
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Project Management 

 

Issue with activities from NSOs that are released before lot is in production 

Defect #:  001-00-1-21213 

Ticket #:  001-00-240232 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   NSO > Lot Matrix > NSO(s) for a lot > Manage > Release 

In some cases, when a NSO was processed all the way to the ‘Released’ step before the 

lot was released to production, the quantities for the activities on the NSO estimate were 
not carried over to the activity list. This has been corrected. 

 

Issue with current budgets for activities when using Review Missing Activities feature 

Defect #:  001-00-1-21059 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Home > PM > Lot Matrix > Update Wizard > Review Missing Activities > Base tab 

Home > PM > Lot Matrix > Update Wizard > Review Missing Activities > Option tab 

In some cases the current budget figure was not added when activities were added using 
the Review Missing Activities feature. This has been corrected. 

 

Issue with Activity/Activity package numbers when using Review Missing Activities feature 

Defect #:  001-00-1-20875 

Ticket #:  001-00-239215, 001-00-239329 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > Update Wizard > Review Missing Activities > Base tab 

PM > Lot Matrix > Update Wizard > Review Missing Activities > Option tab 

In some cases the activity and activity package numbers were duplicated when using the 
review missing activities feature. This has been corrected. 

 

Company Purchase Order pre-fixes not applied on POs when there are no Project level pre-fixes 

Defect #:  001-00-1-20638 

Ticket #:  001-00-238352 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Purchasing Settings > System Generated PO Prefix 

Admin > Company Setup > Purchasing Settings > Manual PO Prefix 

When purchase order prefixes are not defined at the project level, the company level 
prefixes was not applied to purchase orders. This has been corrected. 
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Issue with module navigator when generating POs for a NSO 

Defect #:  001-00-1-20188 

Ticket #:  001-00-237014 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   When working viewing a NSO in the NSO module and the 'Apply to PO' link was clicked, 

you would be take taken to the PM module, but the module navigator was not updated. 
This has been corrected. 

 

Issue with count of activities on the activity list page 

Defect #:  001-00-1-20683 

Ticket #:  001-00-237878 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > Activity List > Standard View  

PM > Lot Matrix > Activity List > Budget View 

When looking at the count at the bottom of the activity list pages it shows the number of 

activities shown on the current list instead of the count of all the activities. This has been 

corrected. 

  

Admin 

 

Issue with Attributes tab when looking at Option details from Admin > Projects > Plans > Options > View 

Defect #:  001-00-1-20029 

Ticket #:  001-00-236464 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Plans > Options > View > Attributes tab 

When the Attributes tab was clicked on this page, the user was taken to the man option in 

DL > Options, rather than viewing the attribute details in the Admin section. This has 

been corrected. 

 

Proper evaluation/error checking of predecessor column for Schedule Template upload 

Defect #:  001-00-1-20852 

Ticket #:  001-00-229950 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Data Upload Wizard > Schedule Templates 

The following rules have been added to the validation of the predecessor value, with 
helpful error notes including the cell location on the spreadsheet: 

• Multiple predecessors separated by commas are allowed, e.g. 5,6,7 or 5, 6, 7. 

• A Phase cannot have a predecessor. 

• A Phase cannot be a predecessor. 
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Error message when an invalid state is included in Trade Partner data upload 

Defect #:  001-00-1-20027 

Ticket #:  001-00-236461 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Data Upload Wizard > Trade Partners 

When an invalid value for State is included on one of the records of the spreadsheet when 

uploading Trade Partner information an error message was shown. This has been 
corrected to show the location if the issue on the spreadsheet. 

 

'Plan Number' should not be a required field on the legacy buyers upload 

Defect #:  001-00-1-21489 

Ticket #:  001-00-240719 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Data Library > Legacy Buyers 

The Legacy Buyers upload process has been updated. The ‘Plan Number’ field is no longer 
required since it is not a required field for plans. 

 

Issue with text survey fields when used on the WIK Form 

Defect #:  001-00-1-20270 

Ticket #:  001-00-237338 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Project Settings > Webkit Prospect Form 

In some cases, the generated WIK prospect form was not accepting ZIP codes entered in 

regular question fields. This has been corrected. 

 

Data Library 

 

Issue with scope of work of activities on options when adding option to plan 

Defect #:  001-00-1-20854 

Ticket #:  001-00-233250 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Data Library > Plans > Options > Add Option Code  

When an option was added to a plan, the scope of work data for the activities on those 
options did not carry over. This has been corrected. 
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Issue with activity packages on the option activities edit page 

Defect #:  001-00-1-21162 

Ticket #:  001-00-240028, 240432 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Data Library > Options > Edit > Edit Activities  

In some cases the edit activities page for options was not allowing correct entry of 

percentages for draw activity packages. This has been corrected. 

 

Bidding & Contracting 

 

Issue with demotion of unit of measure contracts 

Defect #:  001-00-1-21661 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Bidding & Contracting > Contracts > Unit of Measure >Promote 

In some cases an error message was shown when trying to promote the order of a unit of 
measure contract. This has been corrected. 

 

Archived activities hidden from Compare Bid/Contract pages 

Defect #:  001-00-1-19155 

Ticket #:  001-00-233689 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Contracts > Compare 

BC > Contracts > Compare > Option  

BC > Bids > Compare  

BC > Bids > Compare > Option  

Archived activities are now hidden from these compare pages. 

 

Service 

 

Issue when entering phone/fax numbers for associated people 

Defect #:  001-00-1-20679 

Ticket #:  001-00-238519 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Owners > Owner Name > Associate Person 

CS > Owners > Owner Name > Associated People tab > Edit  

When entering phone and fax numbers for an associated person the first three digits of 

the phone/fax number that were typed in were not saved, instead the first three digits for 
the main owner's phone number were used. This has been corrected. 
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Issue with the ‘From’ email address for service emails 

Defect #:  001-00-1-21031 

Ticket #:  001-00-239561 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Owners > Owner name > Email this Owner  

When the 'From' email address was manually edited the typed in email address was not 

shown on the received email. This has been corrected. 

 

Issue with how details of emails from email history for Owners is shown 

Defect #:  001-00-1-21380 

Ticket #:  001-00-240743 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Owners > Owner Name > Email History < Click on an email subject  

When the subject of an email in the email history for an owner was clicked, the HTML code 
of email history was shown rather than the correct HTML format. This has been corrected. 

 

NSO 

 

Issue with NSOs from terminated SPECs 

Defect #:  001-00-1-20787 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > SPEC Accepted > Actions > Terminate SPEC 

In some cases when a SPEC was terminated some of the NSOs on the SPEC were not 

terminated, which would prevent the lot from being pulled from SPEC. This has been 
corrected. 

 

Documents 

 

@@builder_name_global@@ tag not working on service emails 

Defect #:  001-00-1-20280 

Ticket #:  001-00-240402 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The @@builder_name_global@@ tag did not work on service emails. This has been 

corrected. 
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Reports 

 

Update to the view of the PDF version of on-demand reports 

Defect #:  001-00-1-21118 

Ticket #:  001-00-239313 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > Report Name > More Actions > Print (PDF) 

The PDF generated from on-demand reports has been updated to try to fit more data from 
the reports on the PDF page size. 

 

Messages  

 

Agreement Submitted message missing information 

Defect #:  001-00-1-21581 

Ticket #:  001-00-239914 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The notification message generated when an agreement is submitted was missing the 
buyer’s name. This has been corrected.  

 

Update of messages related to NSO quotes 

Defect #:  001-00-1-20413 

Ticket #:  001-00-219841 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   All notification messages related to NSO quotes have been updated to show information 

clearly.  

 

Accounting 

 

Trade Partner drop down shows lot address instead of Trade Partner Name on accounting log 

Defect #:  001-00-1-21079 

Ticket #:  001-00-239911 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Accounting > Log > Audit # > Approved tab  

The 'Trade Partner' drop down filter was showing the lot address instead of the TP Name 

on accounting log. This has been corrected. 
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Issue with accounting QuickBooks account name fields 

Defect #:  001-00-1-20271 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Accounting > Setup  

When QuickBooks is the selected accounting package, these 3 fields are shown: Accounts 

Payable Account Name, Work-In-Progress Account Name, Purchase Order Account Name. 

When spaces or other non-alphanumerical characters were entered in these field an error 
would be shown. This has been corrected. 

 

Trade Partners 

 

Issue with the Message forwarding default for Trade Partner NSO messages 

Defect #:  001-00-1-20148 

Ticket #:  001-00-236720 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The message forwarding setting default for NSO messages for new Trade Partners users 

was to ‘Forward' instead of ‘Don’t Forward’ like all other messages. This has been 
corrected. 
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BuildTopia Product Roadmap 

These are some of the new features and enhancements scheduled for future releases. This information is 

not a complete list of all features that will be in the releases, and is subject to change. If you have any 

suggestions in these areas, please contact the Customer Care.  

 

Hot Fix Version 6.7.2.1, December 2015 

 

• Bug fixes. 

• General usability updates. 

 

Version 6.7.3, Q1 2016 

 

• Updates in Bidding and Contracting – 1st phase. 

• DocuSign integration – 1st phase. 

• General usability updates. 

• Bug fixes. 


